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This Style Guide is designed to assist you develop written assessments and documents for 

academic use at Kaplan Singapore.   
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Introduction  

 

The official American Psychological Association (APA) style and referencing guide is 

extremely detailed, covering a range of writing and formatting rules for academic publication.   

 

Additionally, there are a number of alternative referencing and style guides in use, and it is 

possible that as you progress in your academic career you will be required to create works 

conforming to another system.  

 

Kaplan Singapore has chosen APA as it is the most common referencing and style system 

currently used in institutes of higher education.  Additionally, APA has an excellent range of 

on-line support and guides for students to review in order to clarify use in particular 

circumstances.    

 

This particular guide has been designed to help students undertaking programs of study at 

Kaplan Singapore.  It is imperative that as new members of the academic community you 

understand the rules for academic writing expected at a higher education level. 

 

This guide covers the basics of citing sources of information used in your documents and also 

provides a basic guide on the construction of a document used for assessment such as an essay 

or report.  

 

 

In Need of More Help?  

Here at Kaplan Singapore we offer a student Writing Lab  service, which offers two forms of 

assistance to you.  

1) The Writing Lab runs group sessions once per month covering topics such as 

referencing, academic argument development, researching skills, and critical 

thinking, these session are free to attend and usually run for one (1) hour per topic.  

The Student Affairs team can assist in finding out when these are running, and the 

dates will be listed on the Kaplan website.  

2) The Writing Lab also offers one-to-one session for students to meet a senior 

academic staff member to review assignments prior to submission.  It is important 
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to recognise these sessions are only to review the structural aspects of your work 

and not the subject matter or mark your paper.  To arrange a one-to-one session, 

please find the booking system and rules on the Kaplan website.  

 

There is also a range of on-line assistance on writing, referencing, and other important topics 

concerning submission of academic work.  A search of YouTube or Google yields a 

surprisingly large amount of information.  Be careful that you search specially for APA 

guidance.   

 

 

The Basics 

 

The official APA style has many strict rules covering most aspects of document construction.  

However, for the purposes of submission of assessable documents at Kaplan Singapore the 

institute only requires that you adhere to the following rules, and in most cases only a sub set of 

the full APA requirements.   

 

• Cover Page; 

• Headings;  

• Page Margins and Page Numbering; 

• Fonts;  

• Spacing; 

• Quotations; 

• Summarising & Paraphrasing; 

• In-Text Citations; 

• References List; 

 

Each of these formatting aspects are covered in detail with the required rules for submission at 

Kaplan Singapore in the following pages.  
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Setting up Microsoft Word to help with APA style 

 

As each of the points above is covered, there will be – where possible – a tip on how to set up 

Microsoft Word to make it significantly easier to write your documents.  Generally, once set 

up you can simply use a document as a template on future works.  In addition, you may set the 

parameters to default for future use once you have the format correct.  

 

 

Cover Page 

 

The APA style guide stipulates a design that is used specifically in the submission of a major 

dissertation or journal article for publication and as such, the cover page or title page as it is 

also known has a look and feel of a major work.   

 

Rules 

Here at Kaplan Singapore we are a little more relaxed about the cover page and at a minimum 

expect: 

 

• The Title of the Assignment 

• The Date of Submission 

• Your Name (as it appears in the attendance log)   

• Your Student Number  

• Word Count 

• Name of Class and Name of Course   

• Your Lecturers name  

 

Keep the font and size to Arial Size 12 and do not use Bold.  

You can add an image if you feel it is appropriate.  However, it is not a requirement. 
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Tip –  From the tool ribbon in Microsoft Word, select the Insert tab and then Cover 

Page option; there is a range of styles.  However, the “Conservative” is most suited for 

academic submission. There are regions on the template to insert of the required details. 

 

APA Headings 

 

APA permits the use of five (5) levels of headings; each will have specific formatting.  

Realistically, most students will only need to use two or three levels.   

 

Rules  

The important rule is that they must be used in order.  Always use a level 1, then a level 2, then 

a level 3.  The next section starts with a new level 1, and on it goes. You must not use a level 1 

then a level 3 or any such combination.   

 

Also, it is important to understand where to start your text after your heading.  

 

• Level 1 and 2 add a space under the heading and start from the next line;  

• Level 3, 4 and 5 text starts immediately after the heading in normal paragraph font.  

 

 

Level Formats 

 

1) Centred, Boldface, UPPERCASE and Lowercase Headings  

 

2)  Left-aligned, Boldface, UPPERCASE and Lowercase Heading 

 

3)  Indented, boldface, lowercase heading with a period. 

 

4) Indented, boldface, italicized, lowercase heading with a period. 

 

5) Indented, italicized, lowercase heading with a period. 
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Tip  - in Microsoft Word, once you have formatted headings to conform to the APA 

style; select the Home tab from the ribbon tool bar, and highlight the text then right click on the 

corresponding Heading number and select the option to Update to Match Selection.  From 

then onwards, you can create your heading text, then highlight, and format using the Styles 

buttons.    

 

Page Margins and Page Numbering; 

 

Based on the official APA guide, each page should have a running header at the top of the page 

containing the page number and a short (less than 50) word description of the work.  

 

Rules 

However, here at Kaplan Singapore simply include page number and this will suffice.  

 

The Page Margins are to be set at 1 inch or 2.5 cm, and this is to be the same on all four sides of 

the document.   

 

Tip -  For Page Numbers: In Microsoft Word select the Insert tab from the tool bar 

ribbon, and select the Page Number option; there are several styles available. The best style for 

academic purposes is Right Aligned and at the bottom of the page.  

 

Tip -  For Page Margins: In Microsoft word, select the Page Layout tab from the tool 

bar ribbon and select the Margins option.  There is the setting listed as “Normal” which is the 

correct setting.   
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Fonts 

 

There is a level of flexibility for font choices; APA style does not specifically require any 

particular font to be used. However, please note that in many institutes, it is stipulated that a 

particular font family must be used in documents.  

 

The major consideration is that of readability.  It is considered that Serif fonts such as Times 

New Roman improve the readability of the document; while headings and numbers are best in 

Sans Serif fonts such as Ariel as they look significantly better.  

 

The major requirements are that you do not change the font, stick with one and be consistent in 

its use.  

 

Rules 

Fonts to use at Kaplan Singapore: 

 

Headings and Numbers use Ariel, Size 12 

Text use Times New Roman, Size 12 

Reference list use Times New Roman, Size 10 

 

 

Tip –  In Microsoft Word, it is recommended that after you correctly format the font 

size, family and paragraph spacing, you simply update the Normal Style - as it is done for 

updating the Headings – and use this to ensure your paragraphs are consistent across the 

document.   
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Spacing 

 

The space between the elements on your document can have a profound effect on the visual 

appeal of your work and its readability. There are also considerations to be taken into account 

for the intended use of the works. Publications are usually single spaced and those for 

assessment are usually double spaced. The double spacing was traditionally used for lecturers 

to add comments and feedback between the lines of your work.  

 

Rules 

At Kaplan Singapore please use the following format for spacing: 

 

Paragraph text to be 1.5 lines spaced 

Lists such as bullet and number lists use 1.5 spaced 

Reference list use 1.5 lines spaced  

Use a single space between the heading and the paragraph 

Use 2 spaces between the paragraph and the next heading 1  

 

Quotations 

 

Quotations are used for a number of reasons, some for style and others for emphasis. 

Sometimes when you are writing a paper, you may wish to use a quote from a well known 

specialist on the topic you are writing, or perhaps you are quoting a person from the company 

you are writing about. Also you may use a quote to add a stylistic credibility to your work.  

 

Note – for rules of In-Text Citation of Quotes – see the section below  

 

Rules  

• Do not use more than 10% of your total work as quotes from other sources 

 

• If the quote is below 40 words, then it is used in text or in line with the normal 

paragraph structure and has quote marks. Do not change the font from the normal text 

font being used – no italics or size change also. 
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• If the quote is above 40 words, then the quote starts on a new line, and does not use 

quote marks and indent 1.5cm from the left margin. Do not change the font from the 

normal text font being used, no italics or size change also. However, it is to be in single 

line spacing. 

 

• Do not change any words from the original.  

 

Additional Rules 

There are several additional aspects of quotes that can make using them a little complex. These 

include: 

• Using the Latin word sic which translated into English means “as it was written”. 

This is commonly used when you are quoting text that has an error in the original.   

• Using (. . .) which is used to show you have omitted some of the original text. When 

used at the start of the quote or at the end, it is to show the quote as being from the 

middle of the original text to avoid any confusion in interpretation. 

• Using [ ] to include your own information inside the quote; such as correcting 

mistakes, clarifying some ambiguous information such as a location, or clarify an 

acronym use, or also emphasising a particular word.   

 

Summarising & Paraphrasing 

 

It is important to recognise that APA requires that you correctly cite the work of another in 

your document, and correctly reference the source in the reference list; however, the skill to 

paraphrase and summarise is not defined by APA. This is a skill of good writing and practice.  

 

Both paraphrasing and summarising are rather similar in that the aim is to take another’s work 

and retain the ideas and themes and to use your own academic voice in reproducing them in 

your own document. The key difference is that summarising is also aimed at reducing the size 

of the original work, while paraphrasing is aimed at changing it to use your own academic 

voice and not so much to change the size.    

 

Note – for rules of In-Text Citation of Summaries and Paraphrases – see the section below.  
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Rules: 

• Don’t add any of your own ideas or interpretations; remember it is another person’s 

work and you must retain the originality. If you disagree, or seek to add to the work 

with your own ideas, do so in the subsequent paragraphs using good academic augment 

techniques.   

• Paraphrasing is generally the same length as the original work. 

• Do not approach this by simply changing a few words.  Instead, try to actually use 

your own academic voice. 

 

In-Text Citations  

 

The purpose of In-Text citation is to clearly identify the location of another person’s ideas and 

work in your own document. In-Text citation in APA is also referred to as the author date 

system.   

 

Rules: 

• All In-Text citations used in your document must have a corresponding entry in the 

reference list.  

• The In-Text citation is located at the end of the paragraph in which the material is 

located.  

• Only the Author’s last name is used, followed by a comma, followed by the year of 

publication and all is contained in brackets: 

(Johnson, 2013). 

 If there are two Authors: 

  (Johnson & Harris, 2013). 

• If there are more than Two Authors - The rules for using et al., 

o One or Two Authors – do not use  

o Three, Four or Five Authors  

The first citation is like this  

(Johnson, Harris, & Marriott 2013).  

All the rest are like this  

(Johnson et al., 2013).    
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o More than Six authors  

All citations, including the first are like this 

(Johnson et al., 2013). 

  

 

Rules for In-Text Citation of Quotes (also see Addi tional Rules below) 

• For quotes less than 40 words, the citation is located at the end of the quote, after the 

closing quotation mark and includes the author, date and page number 

 (Johnson, 2013, p. 201). 

• For quotes longer than 40 words; the citation is located with the block of quoted text. 

The citation must include the last name, year and page number.  

 

Additional Rules 

Please note there are a number of ways of using the In-Text citation.  Many are considered 

very advanced uses of APA formatting. Here at Kaplan Singapore it is expected that in most 

cases the In-Text citation will differ only when the Author(s) are being used as part of the 

narrative or not or if the citation is an in direct quote.  

 

If you seek to use more than those listed below, please take a look at the APA Blog on 

citations.   

 

An example of each of the major uses is as follows: 

 

• Author is not part of the narrative 

Research shows that consumer behaviour will eventually become more complex and 

challenging to predict (Harris, 2011).  

 

For a quote less than 40 words: 

“Consumer behaviour will eventually become more complex and challenging to 

predict” (Harris, 2011, p. 12). 

 

For a quote larger than 40 words: 

Based on my primary research conducted over two years, I have found that it is 
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apparent there exists a strong correlation between the complexities of modern 

technologies such as the internet and social media and the complexities of the 

behaviour of consumers when purchasing products or services (Harris, 2011, 

p12).    

 

 

• Author is part of the narrative 

Harris has conducted research which shows that consumer behaviour will eventually 

become more complex and challenging to predict (2011). 

 

For a quote less than 40 words: 

In 2011 Harris noted “consumer behaviour will eventually become more complex and 

challenging to predict” (p. 12)  

 

For a quote larger than 40 words: 

In 2011 Harris noted that: 

Based on my primary research conducted over two years, I have found that it is 

apparent there exists a strong correlation between the complexities of modern 

technologies such as the internet and social media and the complexities of the 

behaviour of consumers when purchasing products or services (p12).    

 

• Indirect Quotation 

This is used when a primary source cannot be found. It is recommended that secondary 

sources be avoided, but in some cases it is not possible.  

 

Harris also considers that consumers ... (as cited in Johnson, 2012, p. 14). 

 

In the reference list, it is Johnson that is added in detail 
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References List  

 

The Reference List provides the reader with all of the detailed information required to retrieve 

the original work. There are many sources of information you will be able to access, especially 

the Internet. However, in most cases, websites, journal articles, newspapers, magazines, books 

will constitute the majority of the locations for your information. These have been shown 

below as examples.  

 

If you are using other sources, such as Twitter, Videos or Podcasts, please review the APA 

blog on how to reference these correctly.    

 

 

Basic Common Rules  

• All references are to be in alphabetical order.  

• The titles of the work are to be in italics, and use capitals for the first letter of the major 

words. 

• The authors’ names are written as Family name followed by the First letter of the Given 

Name: 

o Chris Harris  is written as:  Harris, C.  

• Indent all lines after the first line (hanging indentation). 

• For more than one entry by the same author, list them by year of publication – the 

earliest one comes first. 

 

The following are specific examples of how to reference specific forms of information sources, 

first is the format, followed by an example:  

 

• Websites 

 

Author, A. (date). Title of Website [Format description]. Retrieved from http://URL 

 

Harris, C. (2013). Slippers for Real Men Monthly [webpage]. Retrieved From http://slippers.are.awesome 
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• Journal Articles, Newspapers, Magazines 

 

Author, A. (Year). Title of article. Title of Periodical or Newspaper, volume number, pages. 

 

Johnson, R. (2008). The Growing Trend in the Use of Slippers at Work. Current Directions in Psychological 

Science, 18, 3-5.  

 

Marriott, W. (2013, January 7). Why is Everyone Wearing Crocs. The Straits Times, pp. 14.  

 

• Books 

Author, A. (Date). Title of book. Location: Publisher 

 

Harris, C. (2013). Life’s Major Questions can be Answered only while Wearing Slippers. Singapore. Kaplan 

Press. 

 

• Chapter in a book  

 

Author, A. (Year of publication). Title of chapter. Title of book. (pages of chapter). Location: Publisher. 

 

Harris, C. (2013). Colours of Modern Slippers. Life’s Major Questions can be Answered only while Wearing 

Slippers. (pp. 11-15). Singapore: Kaplan Press. 

 

Additional Rules 

The most common additional rules are those of what to do if there is more than one author or 

there is no date or author listed on the material.  

It does not matter what form the original source is – newspaper or journal – simply follow the 

following examples. 

 

More than one author: 

 

Johnson, R,. & Harris, C. (2013). How to Look Attractive While Wearing Slippers. Journal of Psychological 

Abnormalities. Singapore: Kaplan Press.   

 

Johnson, R., Harris, C., & Marriott, W. (2013). How to Eat Char Kway Teow using Chopsticks. Journal of Eating. 

Singapore: Kaplan Press.   
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No Date – use n.d: 

 

Johnson, R., & Harris, C. (n.d). How to Look Attractive While Wearing Slippers. Journal of Psychological 

Abnormalities. Singapore: Kaplan Press.   

 

No Author – use a shortened version of the title of the article or source: 

 

Eating. (2013). How to Eat Char Kway Teow using Chopsticks. Journal of Eating. Singapore: Kaplan Press.   


